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Chapter 1. How the Internet Works


A Note for Early Release Readers

With Early Release ebooks, you get books in their earliest form—the author’s raw and unedited content as they write—so you can take advantage of these technologies long before the official release of these titles.


This will be the 1st chapter of the final book. Please note that the GitHub repo will be made active later on.


If you have comments about how we might improve the content and/or examples in this book, or if you notice missing material within this chapter, please reach out to the editor at shunter@oreilly.com.




I have met very few people in my life who truly know how the internet works, and I am certainly not one of them.


The vast majority of us are making do with a set of mental abstractions that allow us to use the internet just as much as we need to. Even for programmers, these abstractions might only extend as far as what was required for them to solve a particularly tricky problem once in their career. 


Due to limitations in page count and the knowledge of the author, this chapter must also rely on these sorts of abstractions. It describes the mechanics of the internet and web applications, to the extent needed to scrape the web (and then, perhaps a little more). 


This chapter, in a sense, describes the world in which web scrapers operate. The customs, practices, protocols, and standards that will be revisited throughout the book. 


When you type a URL into the address bar of your web browser and hit “enter," interactive text, images, and media spring up as if by magic. This same magic is happening for billions of other people every day. They’re visiting the same websites, using the same applications -- often getting media and text customized just for them. 


And these billions of people are all using different types of devices and software applications, written by different developers at different (often competing!) companies. 


Amazingly, there is no all-powerful governing body regulating the internet and coordinating its development with any sort of legal force. Instead, different parts of the internet are governed by several different organizations which evolved over time on a somewhat ad-hoc and opt-in basis. 


Of course, choosing not to opt into the standards that these governing bodies publish may result in your contributions to the internet simply... not working. If your website isn’t able to be displayed in a common web browser, people likely aren’t going to visit it. If the data your router is sending can’t be interpreted by any other router, that data will be ignored. 


Web scraping is, essentially, the practice of substituting a web browser for an application of your own design. Because of this, it’s important to understand the standards and frameworks that web browsers are built on top of. As web scrapers, we must both mimic and, at times, subvert the expected customs and practices of the internet. 



Networking


In the early days of the telephone system, each telephone was connected by a physical wire to a central switchboard. If you wanted to make a call to a nearby friend, you picked up the phone, asked the switchboard operator to connect you, and the switchboard operator physically created (via plugs and jacks) a dedicated connection between your phone and your friend’s phone. 


Long distance calls were expensive and could take minutes to connect. Placing a long distance call from Boston to Seattle would result in the coordination of switchboard operators across the United States creating a single enormous length of wire directly connecting your phone to the recipient’s.  


Although many technologies over the years contributed to what we think of as “the Internet,” the technology that single-handedly started it all is, inarguably, packet switching. 


In a packet switched network, the packets (messages) carry their own destination address and are routed dynamically to any destination on the network, based on that address. Rather being forced to blindly traverse the single dedicated connection from receiver to sender, the packets can take any path the network chooses.


If the old phone networks were like a zip line — taking passengers from a single destination at the top of a hill to a single destination at the bottom — then packet switched networks are like a highway system, where cars going to and from multiple destinations are able to all use the same roads. 


A modern packet switching network is usually described using the OSI model (Open Systems Interconnection model), which is comprised of seven layers of routing, encoding, and error handling: 



		Physical layer

		Data Link layer

		Network layer

		Transport layer

		Session layer

		Presentation layer

		Application layer




Most web application developers spend their days entirely in layer 7, the application layer. This is also the layer that this book will spend most of its time in. However, it is important to have at least conceptual knowledge of the other layers when scraping the web. For example, TLS fingerprinting, which will be discussed in more detail later, is a web scraping detection method which involves the transport layer.


In addition, knowing about all of the layers of data encapsulation and transmission can help troubleshoot errors in your web applications and web scrapers.  


The physical layer specifies how information is physically transmitted with electricity over the ethernet wire in your house (or on any local network). It defines things like the voltage levels that encode 1’s and 0’s, and how fast those voltages can be pulsed.


The data link layer specifies how information is transmitted between two nodes in a local network. For example, between your computer and a router. It defines the beginning and ending of a single transmission and provides for error correction if the transmission was lost or garbled. 


It’s important to note that, at the data link layer, all devices on a network are receiving the same data at all times — there’s no actual “switching” or control over where the data is going. However, devices that the data is not addressed to will generally ignore the data and wait until they get something that’s meant for them.


The network layer is where packet switching, and therefore “the internet,” happens. This is the layer that allows packets from your computer to be forwarded by a router and reach devices beyond their immediate network. 


The network layer involves the IP (Internet Protocol) part of TCP/IP (Transmission Control Protocol/Internet Protocol). IP is where we get IP addresses from. For instance, my IP address on the global internet is currently 173.48.178.92. This allows any computer in the world to send data to me and for me to send data to any other address from my own address.


Layer 4, the transport layer, concerns itself with connecting a specific service or application running on a computer to a specific application running on another computer, rather than just connecting the computers themselves.  It’s also responsible for any error correction or retrying needed in the stream of data.


TCP (Transmission Control Protocol), for example, is very picky and will keep requesting any missing packets until all of them are correctly received. TCP is often used for file transfers, where all packets must be correctly received in the right order for the file to work.


In contrast, UDP (User Datagram Protocol) will happily skip over missing packets in order to keep the data streaming in. It’s often used for video or audio conferencing, where a temporary drop in transmission quality is preferable to a lag in the conversation.


Because different applications on your computer can have different data reliability needs at the same time (for instance, making a phone call while downloading a file), the transport layer is also where the port number comes in. The operating system assigns each application or service running on your computer to a specific port, where it receives data at.


This port is often written as a number after the IP address, separated by a colon. For example: 71.245.238.173:8080, which indicates the application assigned by the operating system to port 8080 on the computer assigned by the network at IP address 71.245.238.173. 


The session layer is responsible for opening and closing a session between two applications. This session allows stateful information about what data has and hasn’t been sent, and who the computer is communicating with. The session generally stays open for as long as it takes to complete the data request, and then closes.


The session layer allows for retrying a transmission case of a brief crash or disconnect. 



Sessions vs. Sessions


Sessions in the session layer of the OSI model are different from sessions and session data that web developers usually talk about. Session variables in a web application are a concept in the application layer that are implemented by the web browser software.


Session variables, in the application layer, stay in the browser for as long as they need to or until the user closes the browser window. In the session layer of the OSI model, the session usually only lasts for as long as it takes to transmit a single file!




The presentation layer transforms incoming data from a string of 1’s and 0’s into a format that the application can understand and use. It is also responsible for character encoding and data compression. The presentation layer cares about whether incoming data received by the application represents a PNG file or an HTML file, and hands this file to the application layer accordingly. 


The application layer interprets the data encoded by the presentation layer and uses it appropriately for the application. I like to think of the presentation layer as being concerned with transforming and identifying things, while the application layer is concerned with “doing” things. For instance, HTTP, with its methods and statuses is an application layer protocol. The more banal JSON and HTML (because they are file types that define how data is encoded) are presentation layer protocols. 





HTML


The primary function of a web browser is to display HTML (HyperText Markup Language) documents. HTML documents are files that end in .html


Like text files, HTML files are encoded with plaintext characters, usually ASCII (see Text Encoding and the Global Internet). This means that they can be opened with any text editor and read.


This is an example of a simple HTML file:



<html>
  <head>
    <title>A Simple Webpage</title>
  </head>
  <body>
    <!-- This comment text is not displayed in the browser -->
    <h1>Hello, World!</h1>
  </body>
</html> 


HTML files are a special type of XML (Extensible Markup Language) files. Each string beginning with a < and ending with a > is called a tag. 


The XML standard defines the concept of opening or starting tags like <html> and closing or ending tags that begin with a </ like </html>. Between the starting and ending tags, is the content of the tags. 


In the case where it’s unnecessary for tags to have any content at all, you may see a tag that acts as its own closing tag. This is called an empty element tag or a self-closing tag and looks like:



<p />


Tags can also have attributes in the form of attributeKey="attribute value" for example:



<div class="content">
  Lorem ipsum dolor sit amet, consectetur adipiscing elit
</div>



We say that the div tag has the attribute class which has the value main-content. 


An HTML element has a starting tag with some optional attributes, some content, and a closing tag. An element can also contain multiple other elements, in which case they are nested elements.


While XML defines these basic concepts of tags, content, attributes, and values, HTML defines what those tags can and can’t be, what they can and cannot contain, and how they must be interpreted and displayed by the browser. 


For example, the HTML standard defines the usage of the class attribute and the id attribute, which are often used to organize and control the display of HTML elements. 



<h1 id="main-title">Some Title</h1>
<div class="content">
  Lorem ipsum dolor sit amet, consectetur adipiscing elit
</div>


As a rule, multiple elements in the page can contain the same class value, however any value in the id field must be unique on that page. So multiple elements could have the class content, but there can only be one element with the id main-title.


How the elements in an HTML document are displayed in the web browser is entirely dependent on how the web browser, as a piece of software, is programmed. If one web browser is programmed to display an element differently than another web browser, this will result in inconsistent experiences for users of different web browsers.


For this reason, it’s important to coordinate exactly what the HTML tags are supposed to do and codify this into a single standard. The HTML standard is currently controlled by the W3C (World Wide Web Consortium). The current specification for all HTML tags can be found at https://html.spec.whatwg.org/multipage/


The formal W3C HTML standard is probably not the best place to learn HTML if you’ve never encountered it, however. A large part of web scraping involves reading and interpreting raw HTML files found on the web. If you’ve never dealt with HTML before, I highly recommend a book like HTML & CSS: The Good Parts to get familiar with some of the more common HTML tags. 





CSS


CSS (Cascading Style Sheets) defines the appearance of HTML elements on a webpage. CSS defines things like layout, colors, position, size and other properties that transform a boring HTML page with browser-defined default styles into something more appealing for a modern web viewer. 


Using the HTML example from earlier:



<html>
  <head>
    <title>A Simple Webpage</title>
  </head>
  <body>
    <!-- This comment text is not displayed in the browser -->
    <h1>Hello, World!</h1>
  </body>
</html> 


some corresponding CSS might be:


h1 {
  font-size: 20px;
  color: green;
}


This CSS will set the h1 tag’s content font size to be 20 pixels, and display it in green text. 


The h1 part of this CSS is called the selector or the CSS selector. This CSS selector indicates that the CSS inside the curly braces will be applied to the content of any h1 tags. 


CSS selectors can also be written to apply only to elements with certain class or id attributes. For example, using the HTML:



<h1 id="main-title">Some Title</h1>
<div class="content">
  Lorem ipsum dolor sit amet, consectetur adipiscing elit
</div>


the corresponding CSS might be:



h1#main-title {
  font-size: 20px;
}

div.content {
  color: green;
}



A # is used to indicate the value of an id attribute, and a . is used to indicate the value of a class attribute. 


If it’s unimportant what the value of the tag is, the tag name can be omitted entirely. For instance, this CSS would turn the contents of any element having the class content green:



.content {
  color: green;
}


CSS data can be contained either in the HTML itself or in a separate CSS file with a .css file extension. CSS in the HTML file is placed inside <style> tags in the head of the HTML document:



<html>
  <head>
    <style>
      .content {
        color: green;
      }
    </style>
...


More commonly, you’ll see CSS being imported in the head of the document using the link tag:



<html>
  <head>
  <link rel="stylesheet" href="mystyle.css">
...



As a web scraper, you won’t often find yourself writing style sheets to make the HTML pretty. However, it is important to be able to read and recognize how an HTML page is being transformed by the CSS in order to relate what you’re seeing in your web browser to what you’re seeing in code.


For instance, you may be confused when an HTML element doesn’t appear on the page. When you read the element’s applied CSS, you see:



.mystery-element {
    display: none;
}


This sets the “display” attribute of the element to “none,” hiding it from the page. 


If you’ve never encountered CSS before, you likely won’t need to study it in any depth in order to scrape the web, but you should be comfortable with its syntax, and note the CSS rules that are mentioned in this book. 





JavaScript


When a client makes a request to a web server for a particular web page, the web server executes some code to create the web page that it sends back. This code, called server-side code, can be as simple as retrieving a static HTML file and sending it on. Or, it can be a complex application written in Python (the best language), Java, PHP, or any number of common server-side programming languages. 


Ultimately, this server-side code creates some sort of data file that gets sent to the browser and displayed. But what if you want some sort of interaction or behavior — a text change or a drag-and-drop element for example — to happen without going back to the server to run more code? For this, you use client-side code. 


Client-side code is any code that is sent over by a web server, but actually executed by the client’s browser. In the olden days of the Internet (pre-mid 2000’s), client-side code was written in a number of languages. You may remember Java applets and Flash applications, for example. But JavaScript emerged as the lone option for client-side code for a simple reason: It was the only language supported by the browsers themselves, without the need to download and update separate software (like Adobe Flash Player) in order to run the programs. 


JavaScript originated in the mid-90’s as a new feature in Netscape Navigator. It was quickly adopted by Internet Explorer, making it the standard for both major web browsers at the time. 


Despite the name, JavaScript has almost nothing to do with Java, the server-side programming language. Aside from a small handful of superficial syntactic similarities, they are extremely dissimilar languages.


In 1996, Netscape (the creator of JavaScript) and Sun Microsystem (the creator of Java) did a license agreement allowing Netscape to use the name “JavaScript,” anticipating some further collaboration between the two languages (https://www.infoworld.com/article/2653798/javascript-creator-ponders-past--future.html). However, this collaboration never happened, and it’s been a confusing misnomer ever since. 


Although it had an uncertain start as a scripting language for a now-defunct web browser, JavaScript is now the most popular programming language in the world. This popularity is boosted by the fact that it can also be used server-side, using Node.js. But its popularity is certainly cemented by the fact that it’s the only client-side programming language available. 


JavaScript is embedded into HTML pages using the <script> tag. The JavaScript code can be inserted as content:



<script>
  alert('Hello, world!');
</script>



Or it can be referenced in a separate file using the src attribute:



<script src="someprogram.js"></script>


Unlike HTML and CSS, you likely won’t need to read or write JavaScript while scraping the web, but it is handy to at least get a feel for what it looks like. It can sometimes contain useful data. For example:



<script>
  const data = '{"some": 1, "data": 2, "here": 3}';
</script>


Here, a JavaScript variable is being declared with the keyword const (which stands for “constant”) and is being set to a JSON-formatted string containing some data, which can be parsed by a web scraper directly.


JSON, (JavaScript Object Notation) is a text format that contains human-readable data, is easily parsed by web scrapers, and is ubiquitous on the web. We will discuss it further in Chapter 12, “Crawling Through APIs." 


You may also see JavaScript that making a request out to a different source entirely for data:



<script>
  fetch('http://example.com/data.json')
    .then((response) => {
      console.log(response.json());
    });
</script>



Here, JavaScript is creating a request to http://example.com/data.json and, after the response is received, logging it to the console (more about the “console” in the next section). 


JavaScript was originally created to create dynamic interactivity and animation in an otherwise static web. However, today, not all dynamic behavior is created by JavaScript. HTML and CSS also have some features that allow them to change the content on the page. 


For example, CSS keyframe animation can allow elements to move, change color, change size, or undergo other transformations when the user clicks on or hovers over that element. 


Recognizing how the (often literally) moving parts of a website are put together can help you avoid wild goose chases when you’re trying to locate data. 





Watching Websites with Developer Tools


Like a jeweler’s loupe or a cardiologist’s stethoscope, your browser’s developer tools are essential to the practice of web scraping. In order to collect data from a website, you have to know how it’s put together. The developer tools show you just that.


Throughout this book, I will use developer tools as shown in Google Chrome. However, the developer tools in Firefox, Microsoft Edge, and other browsers are all very similar to each other. 


[image: ]
Figure 1-1. The Chrome Developer tools showing a page load from Wikipedia




To access the developer tools in your browser’s menu, use the following list of instructions:




	Chrome


	View→ Developer → Developer Tools



	Safari


	Safari → Preferences → Advanced → Check “Show Develop menu in menu bar" 


Then, using the Develop menu: Develop → Show web inspector



	Microsoft Edge


	Using the menu: Tools → Developer → Developer Tools



	Firefox


	Tools → Browser Tools → Web Developer Tools





Across all browsers, the keyboard shortcut for opening the developer tools is the same, and dependent on your operating system.



	Mac


	Option + Command + I



	Windows


	CTRL + Shift + I





When web scraping, you’ll likely spend most of your time in the Network tab (shown in previous figure) and the Elements tab. 


The Network tab shows all of the requests made by the page as the page is loading. If you’ve never used it before, you might be in for a surprise! It’s common for complex pages to make dozens or even hundreds of requests for assets as they’re loading. In some cases, the pages may even continue to make steady streams of requests during the duration of your stay on them. For instance, they may be sending data to action tracking software, or polling for updates. 



Don’t see anything in the Network tab? 


Note that the developer tools must be open while the page is making its requests in order for those requests to be captured. If you load a page without having the developer tab open, and then decide to inspect it by opening the developer tools, you may want to refresh the page in order to reload it see the requests it is making.  




If you click on a single network request in the Network tab, you’ll see all of the data associated with that request. The layout of this network request inspection tool differs slightly from browser to browser, but generally allows you to see:



		The URL the request was sent to

		The HTTP method used

		The response status

		All headers and cookies associated with the request

		The payload (if a POST request, where data is sent) 

		The response




This information is useful for writing web scrapers that replicate these requests in order to fetch the same data the page is fetching. 


The Elements tab is used to examine the structure and contents of HTML files. It’s extremely handy for examining specific pieces of data on a page in order to locate the HTML tags surrounding that data and write scrapers to grab it. 


[image: ]
Figure 1-2. Right click on any piece of text or data and select “Inspect” in order to view the elements surrounding that data in the Elements tab




As you hover over the text of each HTML element in the Elements tab, you’ll see the corresponding element on the page visually highlight in the browser. Using this tool is a great way to explore the pages and develop a deeper understanding of how they’re constructed. 




 




Chapter 2. Applications of Web Scraping


A Note for Early Release Readers

With Early Release ebooks, you get books in their earliest form—the author’s raw and unedited content as they write—so you can take advantage of these technologies long before the official release of these titles.


This will be the 2nd chapter of the final book. Please note that the GitHub repo will be made active later on.


If you have comments about how we might improve the content and/or examples in this book, or if you notice missing material within this chapter, please reach out to the editor at shunter@oreilly.com.




While web scrapers can help almost any business, the real trick is often figuring out how. Like artificial intelligence, or, really, programming in general, you can’t just wave a magic wand and expect it to improve your bottom line. 


Applying the practice of web scraping to your business takes real strategy and careful planning in order to use it effectively. You need to identify specific problems, figure out what data you need to fix those problems, and then outline the inputs, outputs, and algorithms that will allow your web scrapers to create that data. 


When planning a web scraping project, you should think about how it fits into the following categories:



	Broad vs. targeted


	

		Will you be scraping a single website, or perhaps even a fixed set of pages within that website? If so, this is a very targeted scraping project. 

		Do you need to scrape a fixed number of known websites? This is still a fairly targeted scraper, but you may need to write a small amount of custom code for each website and invest a little more time into the architecture of your web scraper. 

		Are you scraping a large number of unknown websites and discovering new targets dynamically? Will you build a crawler that must automatically detect and make assumptions about the structure of the websites? You may be writing a broad or untargeted scraper. 





	Single run vs. ongoing job


	

		A one-time web scraping project can be quick and cheap to write. The code doesn’t have to be pretty! The end result of this project is the data itself -- you might hand off an Excel or CSV file to business, and they’re happy. The code goes in the trash when you’re done. 

		Any project that involves monitoring, re-scanning for new data, or updating data, will require more robust code that is able to be maintained. It may also need its own monitoring infrastructure to detect when it encounters an error, fails to run, or uses more time or resources than expected. 





	Simple data collection vs. advanced analysis


	

		In cases of simple data collection, the web scraper deposits data into the database exactly as it finds it, or perhaps with a few lines of simple cleaning (e.g. stripping dollar signs from product prices).

		When more advanced analysis is required, you may not even know what data will be important. Here too, more thought must be put into the architecture of your scraper. 






As you read the examples in this chapter, I encourage you to consider which categories each of these projects might fall into, and how the scope of that project might need to be modified to fit the needs of your business. 



eCommerce


Although I’ve written web scrapers that have collected all sorts of interesting data from the web, the most popular request I get is to collect product and pricing data from eCommerce sites. 


Generally, these requests come from people who currently own a competing eCommerce site or are doing research, planning to launch a new product or market. The first metric you might think of in eCommerce is probably “pricing.” You want to find out how your price compares with the competition. However, there’s a huge space of other possibilities and data you may want to collect. 


Many, but not all, products come in a variety of sizes, colors, and styles. These variations can be associated with different costs and availabilities. It may be helpful to keep track of every variation available for each product, as well as each major product listing. Note that for each variation you can likely find a unique SKU (stock-keeping unit) identification code, which is unique to a single product variation and eCommerce website (Target will have a different SKU than Walmart for each product variation, but the SKUs will remain the same if you go back and check later). Even if the SKU isn’t immediately visible on the website, you’ll likely find it hidden in the page’s HTML somewhere, or a JavaScript API that populates the website’s product data. 


While scraping eCommerce sites, it might also be important to record how many units of the product are available. Like SKUs, this information might not be immediately visible on the website, but found hidden in the HTML or APIs that the website uses. Make sure to also track when products are out of stock! This can be useful for gauging market demand, and perhaps even influencing the pricing of your own products if you have them in stock.


When a product is on sale, you’ll generally find the sale price and original price clearly marked on the website. Make sure to record both prices separately. By tracking sales over time, you can analyze your competitor’s promotion and discount strategies. 


Product reviews and ratings are another useful piece of information to capture. Of course, you cannot directly display the text of product reviews from competitors’ websites on your own site. However, analyzing the raw data from these reviews can be useful to see which products are popular or trending.



Marketing


Online brand management and marketing often involves the aggregation of large amounts of data. Rather than scrolling through social media or spending hours searching for a company’s name, you can let web scrapers do all the heavy lifting!


Web scrapers can be used by malicious attackers to essentially “copy” a website with the aim of selling counterfeit goods or defrauding would-be customers. Fortunately, web scrapers can also assist in combating this by scanning search engine results for fraudulent or improper use of a company’s trademarks and other IP. Some companies, such as MarqVision also sell these web scrapers as a service, allowing brands to outsource the process of scraping the web, detecting fraud, and issuing takedown notices. 


On the other hand, not all use of a brand’s trademarks is infringing. If your company is mentioned for the purpose of commentary or review, you’ll probably want to know about it! Web scrapers can aggregate and track public sentiment and perceptions about a company and their brand. 


While you’re tracking your brand across the web, don’t forget about your competitors! You might consider scraping the information of people who have reviewed competing products, or talk about competitors’ brands, in order to offer them discounts or introductory promotions. 


Of course, when it comes to marketing and the internet, the first thing that often comes to mind is “social media.” The benefit of scraping social media is that there are usually only a handful of large sites, which allow you to write targeted scrapers. These sites contain millions of well-formatted posts with similar data and attributes (such as likes, shares, comments) that can be easily compared across sites. 


The downside to social media is that there may be roadblocks in obtaining the data. While some sites, like Twitter, provide APIs, other social media sites protect their data both with technology and lawyers. I recommend that you consult with your company’s legal representation before scraping websites like Facebook and LinkedIn, especially.


Tracking metrics (likes, shares, comments) of posts about topics relevant to your brand can help to identify trending topics, or opportunities for engagement. Tracking popularity against attributes such as content length, inclusion of images/media, and language usage, can also identify what tends to resonate best with your target audience. 


If getting your product sponsored by someone with hundreds of millions of followers is outside of your company’s budget, you might consider “micro-influencers” or “nano-influencers" -- users with smaller social media presences, who may not even consider themselves to be influencers! Building a web scraper to find and target accounts that frequently post about relevant topics to your brand would be helpful here. 







Academic Research


While most of the examples in this chapter ultimately serve to grease the wheels of capitalism, web scrapers are also used in the pursuit of knowledge. Web scrapers are commonly used medical, sociological, and psychological research, among many other fields. 


For example, Rutgers University offers a course called “Computational Social Science,” which teaches students web scraping to collect data for research projects. Some university courses, such as the University of Oslo’s “Collecting and Analyzing Big Data” even feature this book on the syllabus! 


In 2017, a project supported by the National Institutes of Health scraped the records of jail inmates in US prisons to estimate the number of inmates infected with HIV. 1 This project precipitated an extensive ethical analysis, weighing the benefits of this research with the risk to privacy of the inmate population. Ultimately, the research continued, but I recommend the ethical discussion to anyone considering web scraping for research, particularly in the medical field. 


Another health research study scraped hundreds of comments from news articles in The Guardian about obesity, and analyzed the rhetoric of those comments. 2Although smaller in scale that some other research projects, it’s worth considering that web scrapers can be used for projects that require “small data” and qualitative analysis as well. 


Unless you have very niche interests, you may not have given much thought to the promotional practices of Canadian community colleges. In 2016, a comprehensive study was done to scrape and perform qualitative analysis on marketing materials for every Canadian community college. 3 Apparently, modern facilities and “unconventional organizational symbols” are most popularly promoted. 


In economics research, the Bank of Japan published a paper4 about their use of web scraping to obtain “alternative data.” That is, data outside of what banks normally use, such as GDP statistics and corporate financial reports. In this paper, they revealed that one source of alternative data was web scrapers, which they use to adjust price indices. 





Product Building


Do you have a business idea and just need a database of relatively public, common-knowledge information to get it off the ground? Can’t seem to find a reasonably-priced and convenient source of this information just laying around? You may need a web scraper. 


Web scrapers can quickly provide data that will get you a minimum viable product for launch. Here are a few situations in which a web scraper may be the best solution.


A travel site with a list of popular tourist destinations and activities. In this case, a database of simple geographic information won’t cut it. You want to know that people are going to view Cristo Redentor, not simply visiting Rio de Janeiro, Brazil. A directory of businesses won’t quite work either. While people might be very interested in the British Museum, the Sainsbury’s down the street doesn’t have the same appeal. However, there are many travel review sites that already contain information about popular tourist destinations. 


A product review blog. Scrape a list of product names and keywords or descriptions, and use your favorite generative chat AI to fill in the rest. 


Speaking of artificial intelligence, those models require data — often, a lot of it! Whether you’re looking to predict trends or generate realistic natural language, web scraping is often the best way to get a training dataset for your product. 


Many business services products require having closely-guarded industry knowledge that may be expensive or difficult to obtain. Such as a list of industrial materials suppliers, contact information for experts in niche fields, or open employment positions by company. A web scraper can aggregate bits of this information found in various locations online, allowing you to build a comprehensive database with relatively little upfront cost. 





Travel


Whether you’re looking to start a travel-based business or are very enthusiastic about saving money on your next vacation, the travel industry deserves special recognition for the myriad of web scraping applications it provides.


Hotels, airlines, and car rentals all have very little product differentiation and many competitors within their respective markets. This means that prices are generally very similar to each other, with frequent fluctuations over time as they respond to market conditions. 


While websites like Kayak and Trivago may now be large and powerful enough that they can pay for, or be provided with, APIs, all companies have to start somewhere. A web scraper can be a great way to start a new travel aggregation site that finds users the best deals from across the web.


Even if you’re not looking to start a new business, have you flown on an airplane or anticipate doing so in the future? If you’re looking for ideas for testing the skills in this book out, I highly recommend writing a travel site scraper as a good first project. The sheer volume of data and the chronological fluctuations in that data make for some interesting engineering challenges. 


Travel sites are also in a good middle ground when it comes to anti-scraper defenses. They want to be crawled and indexed by search engines, and also want to make their data user-friendly and accessible to all. However, they’re in strong competition with other travel sites, which may require using some of the more advanced techniques later in this book. Paying attention to your browser headers and cookies is a good first step.


If you do find yourself blocked by a particular travel site and aren’t sure how to access its content via Python, rest-assured there’s probably another travel site with the exact same data that you can try.





Sales


Web scrapers are an ideal tool for getting sales leads. If you know of a website with sources of contact information for people in your target market, the rest is easy. It doesn’t matter how niche your area is. In my work with sales clients, I’ve scraped lists of youth sports team coaches, fitness gym owners, skincare vendors, and many other types of target audiences for sales purposes. 


The recruiting industry (which I think of as a subset of sales) often takes advantages of web scrapers on both sides. Both candidate profiles and job listings are scraped. Because of LinkedIn’s strong anti-scraping policies, plugins, such as Instant Data Scraper or Dux-Soup, are often used that scrape candidate profiles as they’re manually visited in a browser. This gives recruiters the advantage of being able to give candidates a quick glance to make sure they’re suitable for the job description before scraping the page. 


Directories like Yelp can help tailor searches of brick and mortar businesses on attributes like “expensiveness,” whether or not they accept credit cards, offer delivery or catering, or serve alcohol. Although Yelp is mostly known for their restaurant reviews, they also have detailed information about local carpenters, retail stores, accountants, auto repair shops, and more. 


Sites like Yelp are for more than just advertising the businesses to customers, the contact information can also be used to make a sales introduction. Again, the detailed filtering tools will help tailor your target market. 


Scraping employee directories or career sites can also be valuable source of employee names and contact information that will help make more personal sales introductions. Checking for Google’s structured data tags (see SERP Scraping) is a good strategy for building a broad web scraper that can target many websites while scraping reliable, well-formatted contact information.


Nearly all the examples in this book are about scraping the “content” of websites -- the human-readable information they present. However, even the underlying code of the website can be revealing. What content management system are they using? Are there any clues about what server-side stack they might have? What kind of customer chatbot or analytics system, if any, is present? 


Knowing about what technologies a potential customer might already have, or might need can be valuable for sales and marketing. 





SERP Scraping


SERP, or search engine results page scraping, is the practice of scraping useful data directly from search engine results without going to the linked pages themselves. Search engine results have the benefit of having a known, consistent, format. The pages that search engines link to have varied and unknown formats — dealing with those is a messy business that’s best avoided if possible.


Search engine companies have dedicated staff whose entire job is to use metadata analysis, clever programming, and AI tools to extract page summaries, statistics, and keywords from websites. By using their results, rather than trying to replicate them in-house, you can save a lot of time and money. 


For example, if you want the standings for every major American sports league for the past 40 years, you might find various sources of that information. http://nhl.com has hockey standings in one format, http://nfl.com has the standings in another format. However, searching Google for “nba standings 2008” or “mlb standings 2004” will provide consistently formatted results, with drill downs available into individual game scores and players for that season.


You might also want information about the existence and positioning of the search results themselves. For instance, tracking which websites appear, and in which order, for certain search terms. This can help to monitor your brand and keep an eye out for competitors. 


If you’re running a search engine ad campaign, or interested in launching one, you can monitor just the ads, rather than all search results. Again, you track which ads appear, in what order, and perhaps how those results change over time. 


Make sure you’re not limiting yourself to the main search results page. Google, for example, has Google Maps, Google Images, Google Shopping, Google Flights, Google News, etc. All of these are essentially search engines for different types of content that may be relevant to your project. 


Even if you’re not scraping data from the search engine itself, it may be helpful to learn more about how search engines find and tag the data that they display in special search result features and enhancements. Search engines don’t play a lot of guessing games to figure out how to display data, they request that web developers format the content specifically for display by third parties like themselves. 


The documentation for Google’s structured data can be found here: https://developers.google.com/search/docs/appearance/structured-data If you encounter this data while scraping the web, now you’ll know how to use it.



1 https://www.ncbi.nlm.nih.gov/pmc/articles/PMC7392638/ 
2 https://www.researchgate.net/publication/321675406_Doing_stigma_Online_commenting_around_weight-related_news_media 
3 https://link.springer.com/article/10.1080/13583883.2016.1193764 
4 https://www.boj.or.jp/en/research/wps_rev/rev_2022/data/rev22e01.pdf
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